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I. PURPOSE 

This document establishes basic format and style conventions for letters the Office of 
New Animal Drug Evaluation (ONADE) issues to sponsors and other outside parties. 

II. STANDING AND IMPACT OF OUR LETTERS 

Our letters are part of official government records and, as such, need to ensure adequate 
and proper documentation of our decisions and transactions. Our letters also can have 
significant impacts on their recipients. Based on their understanding of our letters, 
sponsors may make decisions to reallocate the sponsor’s priorities, time, money, and 
effort to serve the needs of the company. Therefore, we should issue letters that clearly 
and precisely convey our decisions on particular issues. 

III. FORMAT AND STYLE CONVENTIONS 

A written letter is our principal and preferred form for communicating information to 
sponsors or other outside parties. These letters document our decisions as they relate to 
particular issues. Adhering to a set of format and style conventions increases the 
consistency in the quality and appearance of our letters. 

Experts have published style manuals presenting their particular preferred format and 
style conventions for writing letters. These preferred styles and conventions are not 
entirely consistent and they do not remain static over time. The preferred set of 
conventions and styles we have adopted in this document consider several experts’ sets 
of styles and conventions, our past practices, and our need for clarity and consistency in 
the letters we issue. See standard operating procedure 1243.000.007 for information on 
grammar standards for final action packages that undergo a quality control review by the 
Quality Assurance Team. 

If we have developed a template for a particular type of letter, use it. If no other ONADE 
letter template exists, use the Acknowledgment letter template so that your letter is 
consistent with the styles and conventions presented in this document. 

A. Copies of Letters 

Prepare the electronic file for the letter. If the letter pertains to multiple submissions 
within a single administrative file (e.g., investigative new animal drug (INAD) file, new 



1243.3010 

Responsible Office: Office of New Animal Drug Evaluation 
Date: April 5, 2024 

 
2 

 

animal drug application (NADA)) or if the letter pertains to multiple administrative files, 
you may write a single letter to cover all submissions. When closing the submission 
out in Appian, upload an electronic file for each administrative file unless the 
submissions are linked in our Submission Tracking and Reporting System (STARS) 
(see P&P 1243.3030). 

B. Margins 

Use the following margins on all letters: all margins (i.e., left; right, top, and bottom 
margins) should be 1 inch. 

C. Fonts 

Use Arial (11-point) as the principal font family. The predominant font style you should 
use is “regular.” You may use italic and bold styles judiciously for emphasis and 
clarity. You may also use other font effects such as underline, CAPITALIZATION, and 
SMALL CAPITALIZATION sparingly (e.g., When we use the full name of the FEDERAL 
REGISTER it is in small caps.). The overuse of font styles and effects can compromise 
clarity. Do not manually adjust the spacing between characters (i.e., kern fonts). 

To insert a symbol, select the Insert ribbon in Microsoft Word and then select the 
Symbol dropdown. In our documentation, the standard format for the trademark (™) 
and registered trademark (®) symbols is superscript. When inserting the registered 
trademark symbol using the Symbol option, you must manually superscript it to have 
it in the correct format. See P&P 1243.3015 for information on the formatting and use 
of proprietary names in letters and documents sent to sponsors. Always use 11-point 
Arial font when you insert Greek letters and other characters and symbols. Use 
Microsoft Equation or the MathType plug-in for Microsoft Word for statistical equations 
and similar uses. Note: when you use Microsoft Equation or the MathType plug in, 
you need to tag the item as an object and give it alternative text (Alt-Text) in order for 
the information to be section 508 compliant. Use Arial font in equations as well. 

D. 508 Compliance 

Review and Submission summary documents should be created in a manner that 
conforms to Section 508 of the Rehabilitation Act. 

E. Headers 

Letters exceeding one page in length should have a right-justified 10-point header 
beginning 0.5 inches from the top paper edge. This header should be visible on the 
second and subsequent pages.1 Typically, the header consists of the principal 
submission identification, e.g., I-012345-P-0123-EF, on the first line and a “Page x” 
entry on the second line. Example: 

I-012345-P-0123-EF 
Page 2 

If the letter addresses two principal submissions from one document or one 
submission from each of two documents, use two lines to identify the principal 
submissions. Example: 

 
1 To format the header, click on “Page Setup” from the “File” menu of Microsoft Word, select the “Layout” tab, check the “Different 

first page” box, and set the “Header” to 0.5 inches from the edge. 
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I-012345-G-0100-OT 
I-013001-G-0004-OT 

Page 2 

If the letter addresses three or more principal submissions, the first line should identify 
only the first submission listed in the principal submission identifier field followed by 
the phrase “et al.” to indicate the additional submissions. Example: 

N-012635-C-0100-OT, et al. 
Page 2 

Where the letter does not address a submission, the first line of the header should be 
the content of the reference (“Re:”) line. Example: 

Reference line text here 
Page 2 

F. Principal Submission Identification Field 

This field identifies the principal submission(s) to which this letter responds. 
Amending submissions, or other submissions that provide ancillary or supporting 
information, are not principal submissions and are not identified here. The principal 
submission identifier consists of the one uppercase letter designation of the document 
type, the 6-digit document number, the one uppercase letter designation of the 
submission type, the 4-digit submission number, and the two uppercase letter 
subclass code, separated by dashes. 

This field is the top-most text placed on the first page. It begins at the left margin on a 
line that is no less than 0.75 inches below the top margin of 1 inch. When a one-page 
letter is brief, you can begin the letter by placing this field further down the page to 
“center” the letter on the page visually. 

If the letter addresses an issue that applies to a group of principal submissions, 
include all principal submission identifiers in this field. The display order of is 
determined by sequentially alphabetizing by document type, placing in numerical 
order by document number within document type, and, if necessary, placing in 
numerical order by submission number within a document. 

• If the multiple submissions include linked submissions, then display the lead 
submission (that is identified by an L in STARS) first, regardless of document 
type, document number, or submission number followed by the linked 
submissions (identified with an asterisk in STARS) using the display order 
described above. See P&P 1243.3030 for a definition of linked submissions and 
the administrative process to be followed.  

• For a letter that addresses two principal submissions, list the submissions on 
consecutive lines using the display order indicated above.  

• If the letter addresses three or more principal submissions, create a multi-row 
three-column (of equal width spanning the text area (6.25”)) table that is 
sufficiently large to capture all principal submissions. Fill the table cells using the 
display order in a “top to bottom” order within a column and “left to right” by 
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columns. Set the format of the table borders to “None”.2 Left-justify the table cell 
contents. 

Examples: 

I-012345-G-0011-OT 
N-141141-G-0234-OT 

N-100635-C-0100-OT N-113645-C-0101-OT N-141068-C-0052-OT 
N-101314-C-0098-OT N-123045-C-0100-OT N-141071-C-0027-OT 
N-101315-C-0097-OT N-141013-C-0088-OT  

G. Inside Address 

Direct the letter to the attention of the Responsible Official (or the U.S. agent/U.S.- 
based employee, if the sponsor is not a U.S. firm) who signed the Form 356v of the 
paper submission or as listed in the eSubmitter form. Note: When U.S. firms have a 
consultant or other subject matter expert make a submission on their behalf, we 
address the letter to the consultant (i.e., the responsible official). Use the firm name, 
address, and other information from the Responsible Official section (or the U.S. 
agent/U.S.- based employee section) to populate the inside address of the letter. 
However, if you find obvious typographical errors (i.e., spelling) in either the firm 
name, firm address, or responsible official information, use the correct information in 
the inside address instead of using the incorrect information from the form. 

Additionally, if the firm name in the Responsible Official Information section of the 
eSubmitter form (or for paper submissions, in the cover letter) appears to be incorrect 
or is unclear regarding the identity of the drug application sponsor (e.g., if the firm 
name is written in the eSubmitter form or cover letter as “Drug Company Animal 
Health” and the firm name listed in 21 CFR 510.600 is “Drug Company Animal Health, 
a Division of Drug Company Inc.”), contact the responsible official to obtain the 
correct name. Likewise, if there is more than one responsible official involved in the 
submission (e.g., one responsible official made the initial submission and a different 
person is the responsible official for an amendment and you are not sure to whom to 
address the response, contact the sponsor to confirm the correct name to use. Note 
in your review documentation that you contacted the sponsor to clarify the 
information, and if applicable, make note of the corrected name in your review 
documentation and in the Request for QC Review form, and use the corrected name 
in the inside address. 

You may also modify the stylistic presentation (capitalization, punctuation, and 
spacing) of the firm name and the official’s name, titles, and degrees contained in the 
form to match the addressee’s preference in the cover letter. However, do not add 
information (e.g., degrees) if it is not in the information provided in the Form 356v or 
eSubmitter form. The inside address begins two blank lines below the principal 
submission identification field. Example: 

  
 

2 To set the table borders to “None” in Word, select the table (by dragging to highlight the table, clicking in the table and then on the 
“table square” near the top left of the table, or clicking in the table and then clicking (in succession) “Table” on the “Tools” menu, 
“Select” from the drop-down menu, and then “Table” in the secondary menu).  Once the table is selected, click “Format” on the 
“Tools” menu, click “Borders and shading” from the drop-down menu, click the “Borders” tab, click the “None” setting, and accept 
the command by clicking the “OK” button or pressing the “Return” key. 



1243.3010 

Responsible Office: Office of New Animal Drug Evaluation 
Date: April 5, 2024 

 
5 

 

Drug Company International 
Attention: John Doe, DVM, PhD 
Manager, Regulatory Affairs 
1100 Industrial Drive, Suite 500 
Anytown, NJ  55555 

H. Reference Line 

The reference line should briefly (typically 3-8 words) identify the main topic of the 
letter. The reference line begins one blank line below the inside address. Example: 

Re: Request for review of study protocol 2005-123abc-ver3b 

I. Salutation 

Example: 

Dear Dr. Doe: 

J. Body of the Letter 

Do not indent the first line of a paragraph. Each paragraph should begin at the far-left 
margin or, for subordinate paragraphs, at the new margin established by the 
subordinate position of the paragraph. You should separate paragraphs by one blank 
line. 

1. First paragraph 

The first sentence should convey our main decision regarding the issue presented 
in the letter(s) to which we are responding. Use the remaining sentences of this 
paragraph to provide the supporting and limiting information that place the main 
decision or action in the proper and accurate context. 

2. Subsequent paragraphs 

These paragraphs (if needed) should convey all other necessary information to 
provide a complete response for the letter to which we are responding.3 What 
constitutes a complete response may vary with the type and quality of the letter or 
submission. 

3. Closing paragraph 

The final paragraph politely ends the letter. Include a sentence instructing the 
recipient to refer to the date and the principal submission identifier found at the 
top of our letter when submitting correspondence relating to our letter. Identify an 
individual the addressee can contact for further information. If the contact is the 
individual who signs the letter, include their phone number and email address. If 
the contact is someone other than the individual who signs the letter or multiple 
points of contact, identify the individual(s) by name, organizational title, and 
provide their phone number and email address. 

 
3 A complete response means that we have addressed the issues raised in the letter consistent with our regulations and policies. 
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K. Complimentary Closing and Signature Block 

Use “Sincerely,” as the complimentary closing. The closing begins one blank line 
below the closing paragraph. The content of the signature block should conform to 
that established for the individual signing the letter. The first line of the signature block 
should begin three blank lines below the closing. Indent the closing and signature 
block 3 inches from the left margin. Example: 

Sincerely, 
 
 
{see appended electronic signature page} 
Matthew A. Lucia, D.V.M. 
Director 
Office of New Animal Drug Evaluation 
Center for Veterinary Medicine 

L. Enclosure Notation 

Insert the enclosure notation only if additional items are included with the response to 
the sponsor. The enclosure information begins at the left margin two blank lines below 
the bottom of the signature block. The first line is “Enclosure:” (plural if more than one 
enclosure). The second and additional lines are brief descriptions of the enclosures 
(one line per enclosure). 

Example: 

Enclosures: 

Title (or brief description) of enclosure 1 
Title (or brief description) of enclosure 2 

All enclosures itemized in the letter should be included in the final action package and 
designated as “send to firm” in Appian. 

M. cc: Block Notation in Issuing Letters 

Include a cc: block in an issuing letter to indicate that we are sending the letter to 
other parties external to FDA. For example, include a cc: block notation in food-use 
authorization letters for terrestrial species because USDA/FSIS gets a copy of the 
letter. Internal (FDA) routings of the letter are never included in the cc: block of the 
issuing letter. The cc: block begins at the left margin two blank lines below the bottom 
of the signature block. Example: 

cc: 
USDA/FSIS 

IV. WRITING WITH CLARITY 

As discussed in Section II, there are important reasons for you to prepare letters of 
exceptional quality and clarity. When you draft a letter, use plain language writing 
techniques. 4 For example, use the active voice when possible and write at the level 

 
4 See http://www.plainlanguage.gov and http://www.archives.gov/federal-register/write/plain-language/. 

http://www.plainlanguage.gov/
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appropriate for your audience. Writing at a level appropriate to your audience includes 
remembering that they may not be as intimately versed in your area of expertise as you 
are, so keep the use of technical acronyms and jargon to a minimum to clearly convey 
your intended meaning. You may find the use of the Graham methods of pre-drafting, 
drafting, and editing of the letter helpful.5 In addition, use the spell check and grammar 
function of your word processor. Proofread the letter to catch any errors that automated 
spell checking, and grammar tests may not identify. 

V. “CLEAN” ELECTRONIC FILES 

Critically examine the electronic file of the letter to remove all traces of information that 
are not part of the body of the file. All electronic files should be “clean” (see P&P 
1243.3005). 

VI. REFERENCES 

Books 

Graham, D.O. and J.H. Graham. 2002. The Writing System: A step-by-step guide for 
business and technical writers, Preview Press, Fairfax, VA. 

Plain language web sites 

http://www.plainlanguage.gov 

http://www.archives.gov/federal-register/write/plain-language/ 

CVM Policies and Procedures Manual 

1240.2110 – Procedures for Resolving Scientific Data Disagreements within CVM 

CVM Policies and Procedures Manual – ONADE Reviewer’s Chapter 

1243.3005 - Creating Clean Electronic Files 

1243.3015 – Proprietary Names 

1243.3030 – Completing Final Action Packages for Submission Tracking and 
Reporting System (STARS) Submissions 

ONADE Standard Operating Procedures 

1243.000.007 – Grammar Standards for Final Action Packages that Undergo a 
Quality Control Review by the Quality Assurance Team 

VII. VERSION HISTORY 

May 24, 2005 – original version 

July 1, 2005 – minor changes to content of concurrence table (section III. L. 3.) 

 
5 See Graham, D.O. and J.H. Graham, 2002, The Writing System: A Step-by-Step Guide for Business and Technical Writers, 

Preview Press, Fairfax, VA. If you have questions or need help with the procedures, contact the Quality Assurance Team. 

http://www.plainlanguage.gov/
http://www.archives.gov/federal-register/write/plain-language/
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September 4, 2007 – Changed to add subclass code to the submission identifier and 
replace the preparer line with the Other Administrative Information box. Also referencing 
the new P&P 1243.3005. 

December 4, 2008 – Revised to clarify that the file copy of all letters and the file copies of 
enclosures accompanying the letter are printed on pink paper. Removed reference to 
1243.3060 Final document routing and copy distribution, which no longer exists. 

October 14, 2011 – Revised to describe processes changed by implementation of Appian 
and how to final out review documentation electronically. 

October 7, 2015 - Revised to change all margins to 1.0” and remove Appendix 1 
additional instructions for submissions received prior to March 14, 2011. 

June 13, 2016 – Revised to current format, removed instruction to embed fonts, and 
removed mention of submissions made prior to March 14, 2011. 

March 9, 2018 – Revised to clarify procedures regarding the inside address of the letter. 

August 1, 2018 – Revised Section III. F. to include instructions on how to reference linked 
submissions. Also, updated information in the section on closing paragraphs to instruct 
the preparer of the letter to include the email address of the point of contact(s) identified 
in the closing paragraph. 

January 26, 2021 – Updated section III. C. to clarify information about inserting and 
formatting symbols within our documents. 

July 16, 2021 – Updated the inside address section to clarify that when there is a U.S. 
Agent, the letter is addressed to them and the Sponsor name is not included in the 
address block. 

July 21, 2022 – Quality system review for minor formatting updates. 

December 8, 2022 - Section III. G. was updated to include information on what to do 
when more than one responsible official is involved in a sponsor’s submission. 

March 29, 2023 - Updated the information on standards to reflect the office switch to Arial 
11-point font as our standard font. To bring all office quality system documentation into 
compliance with the FDA Visual Identity Program approved fonts, ONADE has adopted 
Arial 11-point font. The font of this document was changed from Verdana 10-point font to 
Arial11-point font. 

April 5, 2024 – Edited section III. to include reference to the SOP on grammar standards 
for final action packages that undergo a quality control review by the QA Team. 
Reviewers may choose to apply those standards to other letters they prepare. Edited 
section III. G. to clarify to clarify that a U.S. firm may have consultants make submissions 
on the firm’s behalf. In that case, we will send our response letter to that consultant as 
they are the responsible official for the submission. The document was also put into the 
current template and format for the office and minor grammatical corrections made. 
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